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Chapter I    

Welcome
Welcome to Childcare Professional. This guide will give you a tour of the capabilities of Childcare Professional and give you a
step-by-step demonstration of the features that you will be using most often. We recommend that you start at the beginning and
work through the book as each demonstration builds upon the last. If you are not comfortable working with the Windows or
Macintosh operating system that you have, you may wish to have your Windows or Macintosh manual available.

Introduction

Childcare Professional is a powerful and easy-to-use accounting and information management system for Childcare Providers. It
frees you from time-consuming paperwork and record keeping.

Accounts can be created to manage your bank accounts, credit cards and receivables. Each account can be balanced and statements
can be printed. With the Full Accounting, you can calculate and track Payroll transactions. You can set up budgets and enterprises
to monitor how your business is progressing.

Parent & Child information is tracked easily with flexible schedules, rates, immunizations, reimbursement tiers, sponsors, contacts
and notes.

The Childcare Roster and Employee Roster take full advantage of the schedules you set up to automatically create timecards for
the child or employee attendance. Childcare Professional will automatically calculate bills for parents and hours for employees.

Menus can be easily planned with the ability to create entire meals that meet your food program’s standards that you can drop into
the menu at any point. You can even print out a grocery list organized in a convenient manner tailored for your favorite grocery
stores.

You can use the Activity Planner to create an activity schedule for each day of the month. You can even attach additional text files
to each activity if you need more information or formatted printouts.

Year 2000

Kask Software recognizes that the Year 2000 is a serious business issue and is committed to make sure that Childcare Professional
is compliant the Year 2000 and beyond. Unfortunately, no matter how prepared we are for the Year 2000, computer software relies
on your computer’s BIOS to be Year 2000 compliant. You should have your computer checked for compliance also.
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Chapter II    

Installation
To use Childcare Professional, you must first install the software onto the hard drive of your computer. This section of the User’s
Guide will cover what minimum hardware you must have to use Childcare Professional and how to install it on your computer.

System Requirements

The minimum recommended requirements for running Childcare Professional:

Requirements Windows Macintosh
Processor Pentium PPC

OS Windows 95/98 OS 7.1.2

RAM 16 MB 16 MB

Hard Drive 20 MB 20 MB

Installing in Microsoft Windows 3.1, 95 & 98

Ø  To Install in Windows 3.1, 95 & 98:

1. Close all open applications.
2. Insert the Childcare Professional Disk #1 into your floppy drive or the Childcare Professional CD into your CD drive.
3. If you are installing from a disk or your CD doesn’ t start automatically, Select Run… from your Start Menu.
4. Type A:\SETUP.EXE. If you are installing from a CD, replace A with the drive letter of your CD drive. Click on OK.
5. The installation of Childcare Professional will begin. Follow the directions on the screen and, if necessary, replace the

disks in your floppy drive with the next one in the series when prompted to do so.

Installing on the Macintosh

Ø  To Install on the Macintosh:

1. Close all open applications.
2. Insert the Childcare Professional Disk #1 into your floppy drive or the Childcare Professional CD into your CD drive.
3. If you are installing from a disk or your CD doesn’ t start automatically, open the Childcare Professional disk icon and

double-click on the Childcare Professional Setup icon.
4. The installation of Childcare Professional will begin. Follow the directions on the screen and, if necessary, replace the

disks in your floppy drive with the next one in the series when prompted to do so.
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Chapter III    

Setup
To start using Childcare Professional, there are a few options that must be setup for your childcare facility. This section will cover
what you need to do to setup your data.

Data Sets

In Childcare Professional, a Data Set is a group of the data files required for tracking all the information for your childcare facility.

When you start Childcare Professional for the first time, it will create a Data Set for you called Database. Whenever it creates a
new Chart of Accounts, The Standard Chart of Accounts window appears to prompt you about how you want to create your new
Chart of Accounts. You can leave your Chart of Accounts empty so that you can create your accounts from scratch. Or you can
select to use one of the standard Charts of Accounts available to Childcare Professional. To use one of the standard Charts of
Accounts, select the type from the list of standard Charts of Accounts.

You can also choose to have all of the names of your accounts converted to uppercase. To have them all converted, select the Use
All Uppercase Accounts Names box.

When you have made your selections for your Chart of Accounts, click the Ok button to have Childcare Professional build the files
you need.
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With Childcare Professional, you can create as many Data Sets as you need. You can create a separate Data Set for each year of
your business, for your business and personal records to keep them separate or for each business you want to track.

Ø  To create a new Data Set:

1. Select Data Sets… from the File Menu. The Data Set Management window will appear.
2. Click on the Add button. The Create New Data Set window will appear. Enter the name of the new Data Set you would like

to create.
3. Click on the Ok button. Your new Data Set will appear on the list in the Data Set Management window.

����������	��� 	�
�

�
��	������������	��� 	�
�

�
��	������������	��� 	�
�

�
��	������������	��� 	�
�

�
��	��

You can remove Data Sets that you no longer need with the Data Set Management window. Remember that once a Data Set has
been removed, all the data contained in the Data Set is permanently removed from your hard drive. Only remove Data Sets that
you know are no longer of use to you.

Ø  To remove a Data Set:

1. If the Data Set Management window is not already open, select Data Sets… from the File Menu. The Data Set Management
window will appear.

2. Create a Data Set called REMOVEME by using the instructions in the last section.
3. Select the Data Set on the list of Data Sets that you want to remove.
4. Click on the Remove button.
5. Childcare Professional will warn you that you all the data in the selected Data Set will be lost. Click on the Yes button.

The Data Set has been removed.
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You can switch between Data Sets in Childcare Professional at any time. Childcare Professional uses only the data in the current
Data Set for its displays and reports.



III-2

Ø  To switch to a different Data Set:

1. If the Data Set Management window is not already open, select Data Sets… from the File Menu. The Data Set Management
window will appear.

2. Select the Data Set to which you want to switch from the list of Data Sets.
3. Click on the Select button.
4. Childcare Professional will double-check to make sure you really want to switch to the selected Data Set. Click on the Yes

button.

Childcare Professional will switch to the selected Data Set.

Options

The Options window is where you can set some of the basic information needed by Childcare Professional to operate the way you
want it. It consists of three tabbed pages; General, Accounting and Childcare.
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The General tab of the Options window is where you can set what text editor you want to use, whether you want to be warned
about losing data when you click on a Cancel button and how many Most-Used and Last-Used reports you want listed on your
Reports Menu.

Ø  To set the General options for Childcare Professional:

1. If the Options window is not already open, select Options from the Tools Menu.
2. If the General tab is not selected, click on the General tab.
3. If the Text Editor is not the one you want to use, click on the Browse button. Locate the correct Text Editor, select it and

click on the Select button. The name of the new Text Editor will appear in the box.
4. If you want to be warned about losing data when you click on a Cancel button, make sure the Cancel Warning Box is

checked. If you don’ t want to be warned, make sure the Cancel Warning Box is cleared.
5. Select the number of Most-Used and Last-Used reports you want Childcare Professional to list on the middle and bottom

lists on the Reports Menu.

All the General options have been set. If you are done settings options, click on the Save button. If you need to set other options,
continue with the next section before saving.
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The Accounting tab of the Options window is where you set the percentages used by Childcare Professional’s Payroll, the start of
your fiscal year and the message printed at the bottom of any receipts that you print using Childcare Professional.

Ø  To set the Accounting options for Childcare Professional:

1. If the Options window is not already open, select Options from the Tools Menu.
2. If the Accounting tab is not selected, click on the Accounting tab.
3. If the FICA, FUTA and Medicare percentages are not correct, fill in the correct amounts. The numbers in each blank should

be between 0 and 100.
4. If your facility operates on a non-calendar fiscal year, select the starting Month and Day of your Fiscal Year.
5. Enter the message that you want to appear on the Receipts that you print out.

All the Accounting options have been set. If you are done settings options, click on the Save button. If you need to set other
options, continue with the next section before saving.
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The Childcare tab of the Options window is where you set whether you want to use Child Ratios, whether you want to show Child
Ratios, what the maximum ratio is for your facility and where you can list your license and food program agreement numbers.

Child Ratios are used by some states to keep track of how many children one provider can have. The point values vary by age
group. For instance, if one provider can have up to 4 infants, each infant is worth ¼ or .25 point. If one provider can have up to 20
children 10-12 years old, then each child is worth 1/20 or .05 point. The points are added up for all the children in the provider’s
care and compared to the maximum ratio.

Ø  To set the Childcare options for Childcare Professional:

1. If the Options window is not already open, select Options from the Tools Menu.
2. If the Childcare tab is not selected, select the Childcare tab.
3. If your state uses child ratios as described above, make sure the Use Child Ratios box is checked. If the box is not checked,

Childcare Professional will count the number of children present.
4. If you want the Child Ratios or the total number of children present to be shown on the Childcare Roster, make sure the

Show Child Ratios box is checked.
5. If the Use Child Ratios is checked, enter the Maximum Ratio for your facility. If the Use Child Ratios is not checked,

enter the Maximum number of children allowed at your facility.
6. Enter your license number in the License box.
7. Enter your food program agreement number, if you have one, in the Food Agreement box.

All the Childcare options have been set. If you are done settings options, click on the Save button. If you need to set other options,
go back to the appropriate section before saving.

Company Profile

The Company Profile window is where you enter the basic information about your childcare facility. You will enter your name,
company name, address, telephone and federal tax ID number.

Ø  To fill out the information about your childcare facility:

1. Select Company Profile from the Tools Menu. The Company Profile window will appear.
2. Enter the name for your facility in the Company box..
3. Enter your name in the Name box.
4. Enter your main address in the upper Address box.
5. Enter an alternate address in the lower Address box.
6. Enter the city, state and zipcode for your main address in the City, State and Postalcode boxes.
7. Enter your federal tax ID number in the Tax ID# box. This is usually your social security number unless you have received a

special federal tax ID number for your company.
8. Enter your telephone number in the Phone box.

 The basic information about your facility has been setup. You are ready to start using Childcare Professional.

Import

If you own a previous version of Childcare Professional, the Import window will assist you to bring that information into the
current version so that you can continue where you left off.
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The Import wizard will step you through the process of selecting the information you want to import. It will then import the
information and let you continue using Childcare Professional right away.
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Ø  To import your data from Childcare Professional 2.0:

1. Select Import from the File Menu. The Import window will appear.
2. Select Childcare Professional 2.0 from the Import Types list.
3. Click on the Next button.
4. Click on the Browse button. Childcare Professional will automatically try to locate your old version in its default location.

The C:\CCP20\ directory for Windows or the Childcare Professional folder for Macintosh should be automati-
cally selected. If you installed the original Childcare Professional 2.0 in a different directory, locate the directory where you
installed Childcare Professional 2.0.

5. Click on the Select button. A list of Data Sets for Childcare Professional 2.0 should appear in the lower half of the Import
window. If the list does not appear, then either the directory you selected does not have the Childcare Professional 2.0 pro-
gram in it or you have no data to import. Click on the Browse button to locate the Childcare Professional 2.0 program or
click on the Cancel button to exit the Import window.

6. Select the Data Set that you wish to import.
7. Click on the Next button. Childcare Professional will import the old data into the current version. This process may take

several minutes depending on how much data you have.
8. When the Finished message appears, simply click on the Finish button.

You are now ready to continue using Childcare Professional right away. All the data you previously entered into the old version is
now in the new version.
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Chapter IV    

Maintenance
Childcare Professional includes several maintenance functions to help keep your data running smoothly, fast and safe. These
functions are the Backup & Restore, Archiving Data and Database Maintenance.

Backup & Restore

A computer is a very volatile tool. One power surge and your data files are gone. To help protect your information, Childcare
Professional includes the ability to backup your data to a floppy disk or other removable media so that it can be stored separately
from your computer. And if you need to recover your data, you can restore it back to the hard drive from your backup.

Kask Software recommends that you make two identical backups at least every week. Having two backups means that if one of the
disks is bad, you still have a second copy to restore your data from. If you have a large number of changes made to your data each
day, you may want to backup your data at the end of each day.
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Ø  To backup your data to a floppy drive:

1. Select Backup / Restore from the Tools Menu. The Backup / Restore window will appear.
2. Select Backup so that you can save your data to another location.
3. Click on the Next button.
4. Select the Location you want to save your data to. The default is A:\ which is your floppy drive. If you want to save your

data to a different location, click on the Browse button, select the location and then click on the Select button.
5. Click on the Next button.
6. When you are ready to backup your data, click on the Finish button. Childcare Professional will prompt you when you need

to place a disk in the floppy drive.

Your data has been backed up and is safe. Kask Software recommends that you create two backups just in case one of them
becomes corrupted.
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Ø  To restore your data from a floppy drive:

1. Select Backup / Restore from the Tools Menu. The Backup / Restore window will appear.
2. Select Restore so that you can recover your data from another location.
3. Click on the Next button.
4. Select the Location where your backup is.. The default is A:\ which is your floppy drive. If you want to restore your data

from a different location, click on the Browse button, select the location and then click on the Select button.
5. Click on the Next button.
6. When you are ready to restore your data, click on the Finish button. Childcare Professional will prompt you when you need

to place a disk in the floppy drive.

Your data has been restored from the floppy back to the hard drive.

Archive Data

Sometimes, to make your data files smaller and faster, you may want to remove some of the data for prior years from the current
data files and place it in a separate Data Set. Your current Data Set is smaller and faster and yet you still have access to the
information from prior years. Childcare Professional does this for you in the Archive Data Window.
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If you want to make your current data files smaller and faster, you can remove data from previous years and place it in a separate
Data Set.

Ø  To remove old data from your Data Set:

1. Select Data Sets from the File Menu. The Data Set Management window will appear.
2. Create a new Data Set to save your archived data in. For information on how to create Data Sets, see page III-1.
3. Select the Data Set that you want to remove old data from.
4. Click on the Archive button. The Archive Data window will appear.
5. Select Archive Data On or Before.
6. Enter the Date on or before which all data will be removed from the Data Set.
7. Select the Data Set that you want to place the removed data. It should be the one you just created.
8. Click on the Finish button.

Childcare Professional will remove the data on or before the date you selected and place the removed data in the Data Set that you
selected. To view the old data, simply switch to the Data Set containing the old data. For information on how to switch Data Sets,
see page III-1.
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Childcare Professional can assist you in bringing data back into a Data Set after it was archived. Or you can combine the data from
two Data Sets.

Ø  To bring archived data back into a Data Set:

1. Select Data Sets from the File Menu. The Data Set Management window will appear.
2. Select the Data Set that you want to be the destination for the combined data.
3. Click on the Archive button. The Archive Data window will appear.
4. Select Retrieve Archived Data From.
5. Select the other Data Set that you want to get data from.
6. Click on the Finish button.

Childcare Professional will combine the two Data Sets.

Database Maintenance

Once in a while, data files need to have deleted records cleaned out and have some basic testing to make sure they are readable.
That’s what Database Maintenance does.
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Database Maintenance checks data files for problems and clears out all the old deleted records.

Ø  To check your data files for problems:

Select Database Maintenance from the Tools Menu.
Childcare Professional will warn you that all Childcare Professional windows should be closed to test the data files. If there are
open windows, please close them. Click on ‘Yes’  to continue.

Childcare Professional will clear out all the old deleted records and test each database to make sure there are no general errors.
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Chapter V    

Lists
There are a number of lists that Childcare Professional keeps as references for other files. These lists are for Schedules, Rates,
Reimbursement Tiers, Sponsors, Contacts, Vaccines, Events and Notes. These lists can be entered ahead of time or as you are
filling out the rest of the information in Childcare Professional.

Schedule List

The Schedule List allows you to set up standard schedules that will streamline the logging of hours for both children and employ-
ees. It will also help in the calculation of grocery lists for your menus.
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A schedule can be added for any parent, child and employee. It will be used for both logging their hours and the creation of
grocery lists.

Ø  To create a schedule:

1. Select Family Schedules from the Childcare Menu or Employee Schedules from the Payroll Submenu of the
Accounting Menu if you have Payroll installed. The Schedule List window will appear.

2. Click on the Add button to create a schedule.
3. Enter the schedule’s name in the Schedule box.
4. Click on the Add button to create a new schedule day. The Modify Schedule Information window will appear.
5. Select the Day of the Week that this schedule day is for.
6. Enter the time that they arrive in the Time In box.
7. Enter the time that they leave in the Time Out Box. If they come and go several times a day, don’ t worry. You can add as

many times per day as you need.
8. For Parents & Children, select the meals for which the children will be present.
9. Click on the Update button to save this schedule day.
10. To add another schedule day, click on the Add button again.
11. If the same times are used on other days, click on the Duplicate button. The Modify Schedule Information window will

appear again with the information from the selected schedule day filled in. Simply change the Day of the Week and click on
the Update button.

12. Click on the Done button when the schedule is finished.

The schedule is ready for use by Childcare Professional. When you add a parent, child or employee who needs this schedule,
simply select the schedule name in their Schedule box.

Rates

Childcare Professional allows you to establish a flexible fee rate. You can have a two level rate, minimums, maximums, overtime,
multi-child discounts & memos, and even add your own list of additional charges.
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Ø  To add a rate:

1. Select Rates from the Other Lists Submenu of the Childcare Menu. The Rate List window will appear.
2. Click on the Add button. The Modify Rate Information window will appear.
3. Enter the name for this rate in the Rate box.
4. Enter the name of the Income Account that any charges created using this rate will be credited to. If you need to add an

account, click on the Locate button next to the account list.
5. Enter your basic fee in the first Fee Rate box.
6. Enter the fee period in the Per Period box.
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7. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To add another fee level:

1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want to add another fee level to and click on the Modify button.

2. Check the box next to the second Fee Rate box.
3. Enter the second level fee in the second Fee Rate Box.
4. Enter the cutoff number of hours in the To Hours box.
5. Enter the period for the cutoff hours in the Per Period box.
6. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To add a minimum charge:

1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want to add another fee level to and click on the Modify button.

2. Check the Minimum box.
3. Enter the minimum charge in the Minimum Rate box.
4. Select the Period for the minimum charge.
5. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To add a maximum charge:

If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate List
window will appear. Select the rate that you want to add another fee level to and click on the Modify button.
Check the Maximum box.
Enter the maximum charge in the Maximum Rate box.
Select the Period for the maximum charge.
If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To set the overtime rate:

1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want to add another fee level to and click on the Modify button.

2. If the Modifications tab is not selected, click on the Modifications tab.
3. Enter the overtime rate in the Overtime Rate box.
4. Enter the overtime period in the Overtime Period box.
5. If you want the overtime rate to start at a certain time like the facility’s closing time, check the After box. Enter the time of

day that overtime should start.
6. If you want the overtime rate to start if the child is present over a certain number of hours, check the Over box. Enter the

Number of hours at which overtime should start. Enter the Period for the number of hours.
7. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To set up a multi-child discount rate:
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1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want to add another fee level to and click on the Modify button.

2. If the Modifications tab is not selected, click on the Modifications tab.
3. Check the Multi-Child Discount box.
4. If you want a certain amount deducted from the bill, select Amount. Enter the Amount and Period for the deduction.
5. If you want a certain percentage deducted from the bill, select Percent and enter the Percentage for the deduction.
6. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To change the bill memo for a rate:

1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want to add another fee level to and click on the Modify button.

2. If the Modifications tab is not selected, click on the Modifications tab.
3. Enter the new Bill Memo. There are special codes that you can use to personalize the billing memo. See Appendix A: Memo

Formats.
4. If you are done modifying this rate, click on the Update button, otherwise continue on to the next section.
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Ø  To add other charges to a rate:

1. If the Modify Rates window is not open, select Rates from the Other Lists Submenu of the Childcare Menu. The Rate
List window will appear. Select the rate that you want and click on the Modify button.

2. If the Other Fees tab is not selected, click on the Other Fees tab.
3. Click on the Add button. The Modify Other Fee Information window will appear.
4. Enter the name of the fee in the Name box.
5. Enter the Rate and Period for the fee.
6. Enter the Memo for the fee. There are special codes that you can use to personalize the memo. See Appendix A: Memo

Formats.
7. Select the Income Account to which the fee should be credited. If you need to add a new account, click on the Locate

button next to the account list.
8. Click on the Update button.
9. If you need to add another fee, click on the Add button again.
10. If you are done modifying this rate, click on the Update button.

The rate you have created is now ready to be used by Childcare Professional to automatically calculate the parent’s bills. When
you enter a parent or child that needs this rate, select its name in their Rates box.

Reimbursement Tiers

The reimbursement tiers are used when your facility participates in a food program or you need to charge parents for meals served.
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Ø  To set up a reimbursement tier:

1. Select Reimbursement Tiers from the Other Lists Submenu of the Childcare Menu. The Reimbursement Tier List will
appear.

2. Click on the Add button. The Modify Tier Information window will appear.
3. Enter the name for the Tier in the Title box.
4. Enter the Breakfast, Lunch, Supper and Snack reimbursement amounts in the corresponding boxes.
5. If you are done with this Tier, click on the Update button, otherwise continue with the next section.
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Ø  To set a tier to charge parents for meals:

1. If the Modify Tier Information window is not open, select Reimbursement Tiers from the Other Lists Submenu of the
Childcare Menu. Select the tier you want to have charged to a parents account and click on the Modify button or click on
the Add button to create a new tier as described in the last section.

2. Check the Charge Rates to Parent’s Bill box.
3. Enter the Income Account to which you want the meal charges credited.
4. Enter the Bill Memo for the meal charges. There are special codes that you can use to personalize the billing memo. See

Appendix A: Memo Formats.
5. Click on the Update button.
The Reimbursement Tier is ready to be used by Childcare Professional. Whenever you enter a parent that need this tier level, enter
its name in the Tier box.

Sponsors

Whenever a parent receives assistance or subsidies for childcare either from government agencies, organizations or other people,
you can have Childcare Professional keep track of how much each will pay of the bill using the Sponsor List.
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Ø  To set up a sponsor:

1. Select Sponsors from the Other Lists Submenu of the Childcare Menu. The Sponsor List window will appear.
2. Click on the Add button. The Modify Sponsor Information window will appear.
3. Enter the name of the sponsor in the Name box.
4. Enter the accounts receivable account in the Account box. If you need to add an account, click on the Locate button beside the

account box.
5. Enter the Memo for the sponsor transaction. There are special codes that you can use to personalize the memo. See Appendix

A: Memo Formats.
6. Click on the Update button.

The sponsor is set up and ready to be used by Childcare Professional. Whenever you enter a Parent that needs this sponsor, enter
the name of the sponsor in the Sponsor box and the percentage of the bill that the parent pays in the percentage box on the parent’s
information form.

Contacts

You can add information to parent and child records about contact people for them. The information includes name, address,
phone numbers, company, PIN # and whether they can pickup the child. You can also include a picture of the contact person.
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A contact person can only be added from the Modify Parent Information window or the Modify Child Information window.

Ø  To add a contact person to a parent or child record:

1. Click on the Contacts button in the Modify Parent Information window or Modify Child Information window.
2. Enter the contact’s First Name and Last Name.
3. Enter the contact’s Address.
4. Enter the contact’s City, State and Postalcode.
5. Enter the contact’s Home Phone and any Notes.
6. Enter the contact’s Employer name.
7. Enter the contact’s Work Phone and any Notes.
8. Enter the contact’s Other Phone and any Notes.
9. Enter the contact’s PIN # if they have one and whether they Can Pickup the child.
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10. If you have a picture of the contact in BMP format, click on the Select button, locate the picture on your hard drive and click
on the Open button to add it to their record.

11. Click on the Update button.

The contact person has been added to their record.

Vaccines

Childcare Professional allows you to customize the list of immunizations that you can track for each child. The complete list of
vaccines is kept in the Vaccine List. Each child can have any number of vaccines on their personal list.
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Ø  To add a vaccine to the list of vaccines:

1. Select Vaccines from the Other Lists Submenu of the Childcare Menu. The Vaccine List window will appear.
2. Click on the Add button. The Modify Vaccine Information will appear.
3. Enter the vaccine name in the Immunization box.
4. Enter the vaccine short name in the Abbreviation box.
5. Enter the number of Months at which each shot is due. You can enter up to 10 shots per vaccine.
6. Enter the number of weeks warning you want when a shot will be due in the Warning box.
7. If this is a vaccine that you want added to all children from now on, check the Child Default box.
8. Click on the Update button.

This vaccine has been set up and is ready to be used by Childcare Professional. You can manually add it to a child’s shot record or,
if you checked the Child Default box, it will automatically be added to all children created from this time on.

Events

Childcare Professional helps you keep on top of all your important dates. You can create Event categories such as licensing,
training, fire drills or other disaster drills, CPR and First Aid certifications as well as anything else you need to keep track of.
When it is time to handle one of the events, Childcare Professional will notify you.
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Ø  To create an Event Category:

1. Select Events from the File Menu. The Event List window will appear.
2. Click on the Add button. The Modify Event Information window will appear.
3. Enter the name of the event in the Event box.
4. Click on the Update button.

The event is setup and ready to track.
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Ø  To create an Event reminder:

1. If the Event List window is not open, Select Events from the File Menu. The Event List window will appear.
2. Select the Event that you need a reminder about.
3. Click on the Event Log button. The Event Log window will appear.
4. Click on the Add button. The Modify Event Log Item window will appear.
5. Check the Notify box so that it will remind you of this event.
6. Enter the date on which you want to be notified of this event in the Notice Date.
7. Enter a notification message in the Message box.
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8. Click on the Update button.

The event reminder is logged and ready to remind you on and after the date you selected.
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There are two ways that you can be reminded of events due. Whenever you startup Childcare Professional, if there are any events
due, the Events Notification window will appear. You can also manually check by selecting Events Notification on the Tools
Menu.

Ø  To check on Event Notification:

1. Select Event Notification on the Tools Menu. The Event Notification window will appear with a list of all the events that
need to be dealt with.

2. If you want to take care of one or more of the events see the next section.
3. Click on the Done button.
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Ø  To complete an Event reminder:

1. If the Event Notification window is not open, select Event Notification from the Tools Menu. The Event Notification
window will appear.

2. Select the Event that you want to take care of.
3. Click on the Do Event button. The Do Event window will appear.
4. Enter the date that the event was Completed.
5. If you want a reminder of this event for the future, check the Notify box.
6. If you want a reminder of this event for the future, enter the next reminder date in the Date box.
7. Click on the Update button.

The event is completed and logged in your Event Log for this event. If you elected to have another reminder set, it too will be
listed in the Event.

Notes

There are many places in Childcare Professional that you can keep track of information using the Notes. You can add, and update
notes and you can even remind yourself of an important message using the Childcare Professional Notes.
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Ø  To enter a note in someone’s record:

1. Click on the Notes button in the window of the record to which you want to add a note. The Notes window appears with a list
of notes for that record.

2. Click on the Add button. The Modify Note window will appear.
3. Enter the note in the Message box. The note can be up to 254 characters long.
4. Click on the Update button.
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Ø  To setup a note to be a reminder:

1. Click on the Notes button in the window of the record to which you want to add a reminder. The Notes window appears with
a list of notes for that record.

2. Click on the Add button. The Modify Note window will appear.
3. Enter the reminder in the Message box. The reminder can be up to 254 characters long.
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4. Click on the Notify button.
5. If you want the reminder to appear whenever you startup Childcare Professional, check the Startup box.
6. If you want the reminder to start on a particular date, check the Starting box and enter that date in the Starting Date box.
7. If you want the reminder to end on a particular date, check the Ending box and enter that date in the Ending Date box.
8. Click on the Update button.

Your reminder is setup and you will be notified of it either at startup or whenever you enter the record to which it is attached.
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Ø  To check your reminder messages:

1. Select Message Notification on the Tools Menu. The Message Notification window will appear with a list of all your
reminders that are due.

2. If you want to keep a message but no longer wish to be reminded of it, select the message and click on the No Notify button.
3. If you don’ t need the reminder or the message itself any longer, click on the Remove button.
4. Click on the Done button.
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Chapter VI    

Accounting
The basic accounting features of Childcare Professional include the ability to track assets, liabilities, equities, income and ex-
penses. You can reconcile bank and credit card accounts, track your time-space percentage, keep mileage records and even analyze
your financial position using standard financial ratios.

Chart of Accounts

Your chart of accounts includes all the categories of which you want to keep track. They include your bank accounts, your parents’
billing accounts, credit cards, loans, income and expense categories. Each category must belong to a group. The groups can be
used to summarize a set of related categories such as credit cards or utilities.
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Ø  To add a group account:

1. Select Chart of Accounts from the Accounting Menu. The Chart of Accounts window will appear.
2. Click on the Add button. The Modify Account Information window will appear.
3. Select the Account Type. It can be an Asset, Liability, Equity, Income or Expense group.
4. Enter the Account Number. The account numbers that you can use depend on the account type. Assets numbers are 1000-

1999, Liabilities are 2000-2999, Equities are 3000-3999, Income numbers are 4000-4999 and Expense numbers are 5000-
9999.

5. Enter the Group Account Name.
6. If the group is an asset or liability, you need to select whether the account is a current, intermediate, long term or other asset or

liability meaning how quickly you can sell it or need to pay it.
7. Select Group Account as the account Subtype.
8. Select the Tax Line for this group. Most assets, liabilities and equities have this set to None. Income and expense accounts

are usually set to Schedule C tax lines.
9. The Business Percentage is usually set to 100% meaning that all of it is business related. You can set this percentage to

anything from 0-100%.
10. Click on the Update button.

The group account is setup and ready to use. You can now start adding accounts that use this group account.
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Ø  To add an asset account:

1. If the Chart of Accounts window is not open, select Chart of Accounts from the Accounting Menu. The Chart of
Accounts window will appear.

2. If there is an asset account of the same type or group already in the list of assets, select it so that many of the defaults will
already be set correctly.

3. Click on the Add button. The Modify Account Information window will appear.
4. If the Account Type is not Asset, select Asset from the list.
5. Set the Account Subtype to the correct type of account you are creating. The choices are Cash, Checking, Savings,

Accounts Receivable, Inventory and Other Asset.
6. If the Group Account is not correct, select the Group from the list. If you need to add a group, click on the Locate button

next to the group box.
7. Check the Account Number to be sure that the one Childcare Professional generated for this new account is the one you

want.
8. Enter the Account Name.
9. Select whether the account is a current, intermediate, long term or other asset meaning how quickly you can sell it.
10. If the account is an accounts receivable account, select the Vendor whose name and address you want to appear on the bill.
11. If you want this account to appear on your tax report, select the appropriate Tax Line.
12. Enter the Serial Number or Account Number for this asset.
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13. Enter any Unit Name, if appropriate.
14. The Business Percentage is usually set to 100% meaning that all of it is business related. You can set this percentage to

anything from 0-100%.
15. Enter this account’s Beginning Balance.
16. Enter this account’s Beginning Cost., if appropriate.
17. Enter this account’s Beginning Quantity, if appropriate.
18. If you want to be able to balance this account, check the Reconcilable Account box.
19. Click on the Update button.

The account is setup and ready to use. You can now start adding transactions that use this account.
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Ø  To add a liability account:

1. If the Chart of Accounts window is not open, select Chart of Accounts from the Accounting Menu. The Chart of
Accounts window will appear.

2. If there is a liability account of the same type or group already in the list of liabilities, select it so that many of the defaults will
already be set correctly.

3. Click on the Add button. The Modify Account Information window will appear.
4. If the Account Type is not Liability, select Liability from the list.
5. Set the Account Subtype to the correct type of account you are creating. The choices are Credit Card, Accounts Payable,

Loan, a variety of Payroll accounts and Other Liability..
6. If the Group Account is not correct, select the Group from the list. If you need to add a group, click on the Locate button

next to the group box.
7. Check the Account Number to be sure that the one Childcare Professional generated for this new account is the one you

want.
8. Enter the Account Name.
9. Select whether the account is a current, intermediate, long term or other liability meaning how quickly you need to pay it.
10. If you want this account to appear on your tax report, select the appropriate Tax Line.
11. Enter the Vendor Name for the account.
12. Enter the Account Number for this asset.
13. The Business Percentage is usually set to 100% meaning that all of it is business related. You can set this percentage to

anything from 0-100%.
14. Enter this account’s Beginning Balance.
15. Enter this account’s Beginning Cost., if appropriate.
16. Enter this account’s Beginning Quantity, if appropriate.
17. If you want to be able to balance this account, check the Reconcilable Account box.
18. Click on the Update button.

The account is setup and ready to use. You can now start adding transactions that use this account.
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Ø  To add an income account:

1. If the Chart of Accounts window is not open, select Chart of Accounts from the Accounting Menu. The Chart of
Accounts window will appear.

2. If there is an income account of the same type or group already in the list of income accounts, select it so that many of the
defaults will already be set correctly.

3. Click on the Add button. The Modify Account Information window will appear.
4. If the Account Type is not Income, select Income from the list.
5. Set the Account Subtype to Other Income.
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6. If the Group Account is not correct, select the Group from the list. If you need to add a group, click on the Locate button
next to the group box.

7. Check the Account Number to be sure that the one Childcare Professional generated for this new account is the one you
want.

8. Enter the Account Name.
9. Select the appropriate Tax Line so that this will appear on your tax report.
10. The Business Percentage is usually set to 100% meaning that all of it is business related. You can set this percentage to

anything from 0-100%.
11. Enter the Standard Amount for this account if you usually receive a set amount each time.
12. Enter the Standard Memo for this account.
13. Check it Apply Time-Space Percentage if it applies to this account.
14. Click on the Update button.

The account is setup and ready to use. You can now start adding transactions that use this account.
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Ø  To add an expense account:

1. If the Chart of Accounts window is not open, select Chart of Accounts from the Accounting Menu. The Chart of
Accounts window will appear.

2. If there is an expense account of the same type or group already in the list of expenses, select it so that many of the defaults
will already be set correctly.

3. Click on the Add button. The Modify Account Information window will appear.
4. If the Account Type is not Expense, select Expense from the list.
5. Set the Account Subtype to the correct type of account you are creating. The choices are Depreciation, Payroll and Other

Expense..
6. If the Group Account is not correct, select the Group from the list. If you need to add a group, click on the Locate button

next to the group box.
7. Check the Account Number to be sure that the one Childcare Professional generated for this new account is the one you

want.
8. Enter the Account Name.
9. Select the appropriate Tax Line so that this will appear on your tax report.
10. The Business Percentage is usually set to 100% meaning that all of it is business related. You can set this percentage to

anything from 0-100%.
11. Enter the Standard Amount for this account if you usually pay a set amount each time.
12. Enter the Standard Memo for this account.
13. Check it Apply Time-Space Percentage if it applies to this account.
14. Click on the Update button.

The account is setup and ready to use. You can now start adding transactions that use this account.

Checking Transactions

Using an account setup as a Checking account in your Chart of Accounts, you can keep track of checks, deposits and withdrawals
from your checkbook. All transactions entered on all your accounts are entered in the Transaction Register.
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Ø  To enter a check:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select your checking account from the Account list. If you need to add an account, click on the Locate button next to the

Account list.
3. If you want to enter several checks in a row, click on the Checks transaction type in the lower left corner of the window.
4. Click on the Add button. If you didn’ t select the Checks transaction type, the Choose Transaction window will appear. Click

on the Checks options and then click on the Select button. The Modify Transaction Information window will appear.
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5. Make sure that the Check Number is correct. Childcare Professional will automatically calculate the next Check number
from previously entered transactions.

6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered
transactions.

7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous
transaction for this vendor the information for the rest of the check is entered automatically. You can page through past trans-
actions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the check.
9. Enter the Quantity, if appropriate. The quantity can be the number of hours, gallons of fuel or whatever you need for this

transaction.
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the expense Account that you wish to use for all or part of the transaction amount.
13. If the amount for the expense category is less than the entire amount, enter the Amount for the expense category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the check, then the transaction is balanced and you can click on
the Update button to save it.

The check has been completed and will appear in your register. The balance for the checking account will be updated to reflect the
check.
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Ø  To enter a deposit:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select your checking account from the Account list. If you need to add an account, click on the Locate button next to the

Account list.
3. If you want to enter several deposits in a row, click on the Deposits transaction type in the lower left corner of the window.
4. Click on the Add button. If you didn’ t select the Deposits transaction type, the Choose Transaction window will appear.

Click on the Deposits options and then click on the Select button. The Modify Transaction Information window will ap-
pear.

5. If you want to number your deposits, make sure that the Deposit Number is correct. Childcare Professional will automati-
cally calculate the next Deposit number from previously entered transactions.

6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered
transactions.

7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous
transaction for this vendor the information for the rest of the deposit is entered automatically. You can page through past
transactions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the deposit.
9. Enter the Quantity, if appropriate. The quantity can be the number of hours, gallons of fuel or whatever you need for this

transaction.
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the income Account that you wish to use for all or part of the transaction amount.
13. If the amount for the income category is less than the entire amount, enter the Amount for the income category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the deposit, then the transaction is balanced and you can click
on the Update button to save it.
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The deposit has been completed and will appear in your register. The balance for the checking account will be updated to reflect
the deposit.
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Ø  To enter a withdrawal or banking fee:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select your checking account from the Account list. If you need to add an account, click on the Locate button next to the

Account list.
3. If you want to enter several withdrawals in a row, click on the Checks transaction type in the lower left corner of the

window.
4. Click on the Add button. If you didn’ t select the Checks transaction type, the Choose Transaction window will appear. Click

on the Checks options and then click on the Select button. The Modify Transaction Information window will appear.
5. Enter a 0 for the Withdrawal Number.
6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered

transactions.
7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous

transaction for this vendor the information for the rest of the withdrawal is entered automatically. You can page through past
transactions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the withdrawal.
9. Enter the Quantity, if appropriate. The quantity can be the number of hours, gallons of fuel or whatever you need for this

transaction.
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the expense Account that you wish to use for all or part of the transaction amount.
13. If the amount for the expense category is less than the entire amount, enter the Amount for the expense category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the withdrawal, then the transaction is balanced and you can
click on the Update button to save it.

The withdrawal has been completed and will appear in your register. The balance for the checking account will be updated to
reflect the withdrawal.

Accounts Receivable

You can track and bill parents by creating an Accounts Receivable account for each one. Enter the account in the Account box of
their record and the automatic billing will place all charges in this account for you. If you want to manually add charges, you
simply enter charges just like you would enter checks and deposits. And payments are entered the same way.
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Ø  To enter a payment on a parent’s account:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select the accounts receivable account you want from the Account list. If you need to add an account, click on the Locate

button next to the Account list.
3. If you want to enter several payments in a row, click on the Payments transaction type in the lower left corner of the

window.
4. Click on the Add button. If you didn’ t select the Payments transaction type, the Choose Transaction window will appear.

Click on the Payments options and then click on the Select button. The Modify Transaction Information window will ap-
pear.
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5. If you want to number your payments, make sure that the Payment Number is correct. Childcare Professional will auto-
matically calculate the next Payment number from previously entered transactions.

6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered
transactions.

7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous
transaction for this vendor the information for the rest of the payment is entered automatically. You can page through past
transactions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the payment.
9. Enter the Quantity, if appropriate
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the cash, checking or savings Account into which you wish to deposit all or part of the transaction amount.
13. If the amount for the category is less than the entire amount, enter the Amount for the category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the payment, then the transaction is balanced and you can click
on the Update button to save it.

The payment has been completed and will appear in your register. The balance for the accounts receivable account will be updated
to reflect the payment.
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Ø  To enter another charge on a parent’s account:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select the accounts receivable account you want from the Account list. If you need to add an account, click on the Locate

button next to the Account list.
3. If you want to enter several charges in a row, click on the Charges transaction type in the lower left corner of the window.
4. Click on the Add button. If you didn’ t select the Charges transaction type, the Choose Transaction window will appear.

Click on the Charges options and then click on the Select button. The Modify Transaction Information window will appear.
5. If you want to number your charges, make sure that the Charge Number is correct. Childcare Professional will automati-

cally calculate the next charge number from previously entered transactions.
6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered

transactions.
7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous

transaction for this vendor the information for the rest of the charge is entered automatically. You can page through past trans-
actions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the charge.
9. Enter the Quantity, if appropriate.
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the expense Account that you wish to use for all or part of the transaction amount.
13. If the amount for the expense category is less than the entire amount, enter the Amount for the expense category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the charge, then the transaction is balanced and you can click on
the Update button to save it.

The charge has been completed and will appear in your register. The balance for the accounts receivable account will be updated to
reflect the charge.
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Credit Card Transactions

You can keep track of your credit card transactions as easily as your checkbook. You enter charges just like checks and payments
just like deposits.
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Ø  To enter a charge on your credit card:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select your credit card account from the Account list. If you need to add an account, click on the Locate button next to the

Account list.
3. If you want to enter several charges in a row, click on the Charges transaction type in the lower left corner of the window.
4. Click on the Add button. If you didn’ t select the Charges transaction type, the Choose Transaction window will appear.

Click on the Charges options and then click on the Select button. The Modify Transaction Information window will appear.
5. If you want to number your charges, make sure that the Charge Number is correct. Childcare Professional will automati-

cally calculate the next charge number from previously entered transactions.
6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered

transactions.
7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous

transaction for this vendor the information for the rest of the withdrawal is entered automatically. You can page through past
transactions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the charge.
9. Enter the Quantity, if appropriate.
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the expense Account that you wish to use for all or part of the transaction amount.
13. If the amount for the expense category is less than the entire amount, enter the Amount for the expense category.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button. If the amount you entered is less than the transaction amount, the Modify Transaction Detail

window will remain open with the remaining amount to be categorized. Go back to #12 and repeat until the total amount has
been categorized.

17. If the amounts in the list below the check equal the amount of the charge, then the transaction is balanced and you can click on
the Update button to save it.

The charge has been completed and will appear in your register. The balance for the credit card account will be updated to reflect
the charge.
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Ø  To enter a payment on your credit card:

1. Select Transaction Register from the Accounting Menu. The Transaction Register window will appear.
2. Select the checking account that you are using to pay on your credit card from the Account list. If you need to add an

account, click on the Locate button next to the Account list.
3. If you want to enter several payments in a row, click on the Checks transaction type in the lower left corner of the window.
4. Click on the Add button. If you didn’ t select the Checks transaction type, the Choose Transaction window will appear. Click

on the Checks options and then click on the Select button. The Modify Transaction Information window will appear.
5. Make sure that the Check Number is correct. Childcare Professional will automatically calculate the next Check number

from previously entered transactions.
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6. Make sure that the Date is correct. Childcare Professional will automatically use the most recent date from previously entered
transactions.

7. Enter the Vendor Name. If you need to add a vendor, click on the Locate button next to the Vendor list. If there is a previous
transaction for this vendor the information for the rest of the withdrawal is entered automatically. You can page through past
transactions by pressing the Page Up and Page Down keys.

8. Enter the Amount of the payment.
9. Enter the Quantity, if appropriate
10. Enter the Memo.
11. If you tab past the Memo field, the Modify Transaction Detail window will automatically appear with the amount of the

transaction to categorize.
12. Enter the credit card Account that you wish to pay.
13. Make sure the Amount for the payment is correct.
14. Enter the Quantity, if appropriate.
15. Enter the Memo.
16. Click on the Update button.
17.  If the amounts in the list below the check equal the amount of the payment, then the transaction is balanced and you can click

on the Update button to save it.

The payment has been completed and will appear in your register. The balance for the credit card account will be updated to reflect
the payment.

Reconciliation

You can use Childcare Professional to balance your accounts with your monthly statements. Just enter the statement date, ending
balance and check off all the transactions on the statement. If it doesn’ t balance, double-check your transactions for mistyped
amounts.
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Ø  To reconcile your bank or credit card statement:

1. Select Reconcile Accounts from the Accounting Menu. The Reconcile Accounts window will appear.
2. Select the checking account or credit card account that you want to reconcile from the Accounts list.
3. Enter the Statement Date from your statement.
4. Enter the Ending Balance from your statement.
5. Double-click on each of the transactions listed on your statement. The numbers and amounts in the bottom left-hand corner of

the window will keep track of the transaction totals.
6. The Difference listed in the bottom right-hand corner should be 0 if the reconciliation is successful. If it isn’ t 0, double-

check your transaction amounts and check to make sure you have all the transactions listed on your statement.
7. When the Difference is 0, click on the Done button.
8. Childcare Professional will ask you if you want a reconciliation statement listing the beginning balance, all cleared transac-

tions, the ending statement balance, all uncleared transactions and the current balance for the account. If you want this report,
click on the Yes button.

The account has been balanced. Place your account statement in a safe place in case you need it in the future.

Financial Ratios

Acid Test or Quick Ratio

This measures whether you could pay all your current liabilities if they came due immediately. An Acid Test Ratio of 0.90 or more
is acceptable.

Current Ratio

This measures the ability to pay current liabilities with current assets. A Current Ratio of 1.6 or more is acceptable.
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Debt Structure Ratio

This measures what portion of the liabilities is short term. A Debt Structure Ratio of less than 0.5 is acceptable.

Debt-To-Asset Ratio

This measures what portion of the assets of the company has been financed. A Debt-To-Asset Ratio of less than 0.5 is acceptable.

Debt-To-Equity Ratio

This measures what portion of the equity of the company has been financed. A Debt-To-Equity Ratio of less than 0.5 is acceptable.

Equity Ratio

This measures what portion of the company is actually owned by the owners. An Equity Ratio of 0.5 or more is acceptable.

Capital Turnover Ratio

This measures how profitably assets are used. A Capital Turnover Ratio of 1.0 or more is acceptable.

Vendors

In Childcare Professional, you can use the Vendor List to keep track of the names and addresses of all the people and companies
with whom you do business.
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Ø  To enter information about a vendor:

1. Select Vendors from the Accounting Menu. The Vendor List window will appear.
2. Click on the Add button. The Modify Vendor Information window will appear.
3. Enter the Name of the vendor.
4. Enter the Address of the vendor.
5. Enter the City, State and Postalcode of the vendor.
6. Enter the Telephone number of the vendor.
7. The Last Amount and Last Memo fields are used to store the information used in the last transaction added for this vendor.

They don’ t require editing.
8. Click on the Update button.

The vendor has been added to the Vendor List. It is now ready to use in adding transactions to Childcare Professional.

Time-Space Calculator

The Time-Space Calculator is used to determine the time-space percentage that you can use for expenses that require it.
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Ø  To calculate your time-space percentage:

1. Select Time-Space Calculator from the Accounting Menu. The Time-Space Calculator window will appear.
2. Enter an estimate of the Actual Time your business is open or click on the + button to have Childcare Professional use the

employee and child timecards to calculate the actual time your business was in use.
3. Enter the Total Hours during the period you are using. If you are using a week, enter 168. If you are using a year, enter

8760.
4. Enter the Actual Space used by your business.
5. Enter the Total Space in your facility.
6. Click on the Update button.
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Childcare Professional used the figures to determine your time-space percentage. It is not ready to be used when printing reports
about your income & expenses for the business.
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Ø  To calculate the actual hours for the time-space calculation:

1. If the Time-Space Calculator window is not open, Select Time-Space Calculator from the Accounting Menu. The Time-
Space Calculator window will appear.

2. Click on the + button. The Calculate Hours window will appear.
3. Enter the Start Date for the period you want to use.
4. Enter the End Date for the period you want to use.
5. Click on the Calculate button.

Childcare Professional will use the employee and child timecards to determine the exact number of hours your business was in use.

Mileage

You can track mileage on multiple vehicles with Childcare Professional. Each vehicle has its own mileage log with odometer
readings and mileage totals.
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Ø  To enter a vehicle:

1. Select Vehicles from the Accounting Menu. The Vehicle List window will appear.
2. Click on the Add button. The Modify Vehicle Information window will appear.
3. Enter the Name of the vehicle.
4. Click on the Update button.

The vehicle has been setup and is ready to be used in the mileage tracking.
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Ø  To enter mileage for a vehicle:

1. If the Vehicle List window is not open, select Vehicles from the Accounting Menu. The Vehicle List window will appear.
2. Click on the Mileage button. The Mileage Log window for that vehicle will appear.
3. Click on the Add button. The Modify Mileage Information window will appear.
4. Enter the Date for the mileage readings.
5. If you want to track the odometer, enter the Start and End odometer readings. The mileage will be calculated automatically.
6. Enter the Mileage, if necessary.
7. Click on the Update button.

The mileage will appear on the vehicle’s mileage log and the total number of miles for the vehicle will be updated.
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Chapter VII    

More Accounting
If you purchased the Full Accounting and Payroll version of Childcare Professional then you have the added capability of handling
employees, employee timecards, calculating payroll, budgets and enterprises.

Employees
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Ø  To enter an employee’s information:

1. Select Employees from the Payroll Submenu of the Accounting Menu. The Employee List will appear.
2. Click on the Add button. The Modify Employee Information window will appear.
3. Enter the Name of the employee.
4. Enter the Payroll Expense Account for the employee. If you need to add an account, click on the Locate button next to the

account list.
5. Enter the Schedule for the employee. If you need to add a schedule, click on the Locate button next to the schedule list.
6. Enter any special Certification number that the employee has attained.
7. Enter the Social Security number for the employee.
8. Enter the number of Exemptions the employee is claiming.
9. Enter the employees Wage and Wage Period.
10. Enter the Federal Tax Percentage to withhold.
11. Enter the State Tax Percentage to withhold.
12. If state taxes are a percentage of the gross wages, check the box in the square at the right of the window. If state taxes are a

percentage of the federal taxes, do NOT check the box in the square at the right of the window.
13. Click on the Update button.

The employee is setup and the information can be used by Childcare Professional to log work hours and calculate payroll informa-
tion.

Employee Roster

The Employee Roster is the employee time clock for Childcare Professional. You can check employees in, check them out or just
log their hours. If you have schedules set up for your employees, the Employee Roster will use them.
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Ø  To check an employee in:

1. Select Employee Roster from the Payroll Submenu of the Accounting Menu. The Employee Roster window will appear.
2. Select Not Present from the Status list. The list of employees who are not already checked in will be displayed.
3. Double-click on the employee that you want to check in.
4. Click on the Check In button.
5. If the employee has a schedule selected, the Employee Roster will automatically use the schedule and check the employee in

at that time. If the employee doesn’ t have a schedule for that day, the Modify Employee Roster window will appear so that
you can manually enter the date and time. After you enter the date and time, click on the Update button.

The employee will be moved to the present list with the check in time and date listed.

�����������
��	��� 	��� 	�#�������	������������
��	��� 	��� 	�#�������	������������
��	��� 	��� 	�#�������	������������
��	��� 	��� 	�#�������	�

Ø  To change the check in time:
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1. If the Employee Roster window is not open, select Employee Roster from the Payroll Submenu of the Accounting
Menu. The Employee Roster window will appear.

2. Select Present from the Status list. The list of employees who are checked in will be displayed.
3. Select the employee whose check in time you want to change.
4. Click on the Edit Times button. The Modify Employee Roster window will appear.
5. Change the Time In to the correct time.
6. Click on the Update button.

The corrected time will be listed beside the employee’s name.
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Ø  To check an employee out:

1. If the Employee Roster window is not open, select Employee Roster from the Payroll Submenu of the Accounting
Menu. The Employee Roster window will appear.

2. Select Present from the Status list. The list of employees who are checked in will be displayed.
3. Double-click on the employee to be checked out.
4. Click on the Check Out button.
5. If the employee has a schedule selected, the Employee Roster will automatically use the schedule and check the employee out

at that time. If the employee doesn’ t have a schedule for that day, the Modify Employee Roster window will appear so that
you can manually enter the date and time. After you enter the date and time, click on the Update button.

6. The Timecards Created window will appear so that you can double-check the timecards that were created.
7. If you want to change the times of a timecard, select the timecard and click on the Modify button.
8. If you don’ t want a particular timecard, select the timecard and click on the Remove button.
9. Click on the Done button when you are finished.

The employee is checked out and a timecard was created unless you removed it from the Timecards Created list.
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Ø  To log hours for an employee:

1. If the Employee Roster window is not open, select Employee Roster from the Payroll Submenu of the Accounting
Menu. The Employee Roster window will appear.

2. Select Not Present from the Status list. The list of employees who are not checked in will be displayed.
3. Double-click on the employee for whom you want to log hours..
4. Click on the Log Hours button.
5. If the employee has a schedule selected, the Employee Roster will automatically use the schedule. If the employee doesn’ t

have a schedule for that day, the Modify Employee Roster window will appear so that you can manually enter the date and
time. After you enter the date and time, click on the Update button.

6. The Timecards Created window will appear so that you can double-check the timecards that were created.
7. If you want to change the times of a timecard, select the timecard and click on the Modify button.
8. If you don’ t want a particular timecard, select the timecard and click on the Remove button.
9. Click on the Done button when you are finished.

The employee’s hours have been logged and timecards created unless you removed them from the Timecards Created list.

Employee Timecards

The employee timecards are used by the Calculate Payroll Wizard for figuring the hours worked for hourly employees. It is also
used by the Time-Space Calculator to figure the total number of hours the business is in use.
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Ø  To change an employee’s timecard:
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1. Select Employee Timecards from the Payroll Submenu of the Accounting Menu. The Employee Timecard List will
appear.

2. Select the employee’s name from the Employee list. The timecards for the selected employee will be displayed.
3. Select the timecard to be changed.
4. Click on the Modify button. The Modify Employee Timecard Information window will appear.
5. Change the times to the correct times.
6. Click on the Update button.

The timecard has been modified. If the employee is paid hourly and this timecard already has been included in a payroll transac-
tion, you need to remove the payroll transaction from the Transaction register and use the Calculate Payroll Wizard to recalculate
it.

Payroll
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Ø  To calculate the payroll:

1. Select Calculate Payroll from the Payroll Submenu of the Accounting Menu. The Calculate Payroll Wizard will appear.
2. Enter the Payroll Starting Date.
3. Enter the Payroll Ending Date.
4. Click on the Next button. The Select Employees Step of the Calculate Payroll Wizard will appear.
5. Select the employee or employees for whom you want to calculate payroll.
6. Click on the Next button. The Calculate Payroll Wizard will begin to step through all the employees that you selected in step

2.
7. Check the figures for hours and wages that the Payroll Wizard calculated from timecards and entered from the employee’s

record.
8. Click on the Next button. When you have finished stepping through all the employees chosen, the Calculate Payroll Wizard

will end at the Finish step.
9. If you want to print the payroll stubs or summary reports, make your selection and then click on the Finish button.

The Calculate Payroll Wizard will create all the transactions necessary to complete the payroll calculation. If you want to view the
transactions, open the Transaction Register and find the payroll liability accounts. You will find the transactions there.
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Ø  To record the employees’  paychecks:

1. Select Pay Employees from the Payroll Submenu of the Accounting Menu. The Pay Employees Wizard will appear.
2. Select the employee or employees for whom you want to record payments.
3. Click on the Next button. The Pay Employee Wizard will begin stepping through all the employees that you selected in step

1.
4. Check to make sure that the checking account, check numbers and amounts are all correct.
5. Click on the Next button. When you are finished stepping through all the employees chosen, the Pay Employees Wizard will

end at the Finish step.
6. Enter the Date for the payroll checks.
7. Click on the Finish button.

The employees’  paychecks have been entered into the Transaction Register.
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Ø  To pay the payroll taxes:

1. Select Pay Taxes from the Payroll Submenu of the Accounting Menu. The Pay Taxes Wizard will appear.
2. Enter the Name of the vendor to whom you are paying the taxes is filled in.
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3. Check the Account, Memo, Date and Check Number to make sure they are correct.
4. Select the taxes to pay by checking the boxes to the left of the tax names. If you want to only pay part of the tax in the amount

box, enter only the amount you want to pay.
5. Click on the Finish button.

Budgets

Childcare Professional assists you in creating budgets that you can use to compare how you want to do with how you are actually
doing. You can use the budgets to see if there are any income or expense categories that are going over or under budget too much.
You may need to monitor those categories more closely.
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When you create a budget, you have several choices. You can duplicate an existing budget, create a budget from scratch, create a
budget with the complete list of income & expense accounts or create a budget with the complete list of income & expense
accounts along with the balances from a certain time period.

Ø  To duplicate an existing budget:

1. Select Budgets from the Accounting Menu. The Budget List window will appear.
2. Select the budget that you want to duplicate from the list.
3. Click on the Duplicate button. The Modify Budget Name window will appear.
4. Enter the Name of the new budget.
5. Click on the Update button.

Ø  To create a budget:

1. Select Budgets from the Accounting Menu. The Budget List window will appear.
2. Click on the Add button. The Modify Budget Name window will appear.
3. Enter the Name of the new budget.
4. If you want to create a budget and want to manually add accounts, select Create from Scratch.
5. If you want to have all the income and expense accounts added but without preset balances, select Insert Account Names

Only.
6. If you want to have all the income and expense accounts added and include balances for a specified period of time, select

Insert Account Names & Balances. Enter the Start Date and End Date for the period of time for which you want to
calculate the balances.

7. Click on the Update button.

Childcare Professional created a budget and added the accounts and balances if you specified that you wanted them.
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Ø  To add an account to a budget:

1. Select Budgets from the Accounting Menu. The Budget List window will appear.
2. Select the budget to which you want to add an account.
3. Click on the Accounts button. The Budget Accounts window will appear.
4. Click on the Add button. The Modify Budget-Account Information window will appear.
5. Select an Account from the account list. If you need to add an account, click on the Locate button next to the account list.
6. Enter the monthly, quarterly and yearly budget amounts.
7. Click on the Update button.

The account and budget information was added to the list of accounts for this budget.

Enterprises
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In Childcare Professional, you can create an enterprise, which is like a business within a business. For instance, you can keep track
of your meal income and expenses as an enterprise to see whether you should provide the service yourself or possibly hire it done
by an outside agency.
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Ø  To create an enterprise:

1. Select Enterprises from the Accounting Menu. The Enterprise List window will appear.
2. Click on the Add button. The Modify Enterprise Name window will appear.
3. Enter the Enterprise name.
4. Click on the Update button.

The enterprise has been added to the list of enterprises.
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Ø  To add an account to an enterprise:

1. Select Enterprises from the Accounting Menu. The Enterprise List window will appear.
2. Click on the Accounts button. The Enterprise Accounts window will appear.
3. Click on the Add button. The Modify Enterprise-Account Information window will appear.
4. Select the Account from the account list. If you need to add an account, click on the Locate button next to the account list.
5. Enter the Percentage of the account balance that should be credited to this enterprise.
6. Click on the Update button.

The account has been added to the selected enterprise.
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Chapter VIII    

Childcare

Parent Information

The Parent List and Modify Parent Information windows are where you keep track of all the information you need about the
parents. You can track their names, address, phone numbers, billing information, medical information, contacts, picture, PIN # and
who can pick up the children.
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Ø  To add a parent to the list:

1. Select Parents & Children from the Childcare Menu. The Parent List window will appear.
2. Click on the Add button. The Modify Parent Information window will appear.
3. Enter the Parent name.
4. Enter the parent’s Address, City, State and Postalcode.
5. Enter the parent’s Home phone number.
6. Enter the parent’s Employer
7. Enter the parent’s Work and Other phone numbers.
8. If you want to add a picture of the parent, click on the Select button beneath the picture block. Locate the picture and the

click on the Open button.
9. Click on the Misc tab.
10. Enter the parent’s PIN #.
11. Select Active from the Status list.
12. Enter their Billing Period and Billing Start Date.
13. If the parent receives assistance from a sponsor, enter the Percentage of the bill that the parent pays.
14. If this parent has a schedule, enter the name of the Schedule. If you need to add a schedule, click on the Locate button next

to the Schedule list.
15. Enter the name of the parents Fee Rate. If you need to add a rate, click on the Locate button next to the Fee Rate list.
16. Enter the name of the parents Accounts Receivable Account. If you need to add an account, click on the Locate button

next to the Account list.
17. Enter the name of the parents Reimbursement Tier. If you need to add a tier, click on the Locate button next to the Tier

list.
18. If the parent receives assistance from a sponsor, enter the Sponsor. If you need to add a sponsor, click on the Locate button

next to the Sponsor list.
19. Enter the Bill Memo. This memo appears on all the charges added to the parent’s accounts receivable account. There are

special codes that you can use to personalize the billing memo. See Appendix A: Memo Formats.
20. Click on the Update button.

The parent has been added to your parent list. You can now view their child list by selecting the parent and clicking on the
Children button.
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Ø  To enter information about a spouse:

1. Select Parents & Children from the Childcare Menu. The Parent List window will appear.
2. Select the parent to whose record you want to add a spouse.
3. Click on the Modify button. The Modify Parent Information window will appear.
4. Click on the Misc tab.
5. Click on the Spouse button. The Modify Spouse Information window will appear.
6. Enter the Spouse name.
7. Enter the spouse’s Address, City, State and Postalcode.
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8. Enter the spouse’s Home phone number.
9. Enter the spouse’s Employer
10. Enter the spouse’s Work and Other phone numbers.
11. Enter the spouse’s PIN #.
12. If the spouse can pick up the child, check the Can Pickup box.
13. If you want to add a picture of the spouse, click on the Select button beneath the picture block. Locate the picture and the

click on the Open button.
14. Click on the Update button.
15. Click on the Update button in the Modify Parent Information window.

The spouse’s information has been added to the parent’s record.
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Ø  To enter medical information:

1. Select Parents & Children from the Childcare Menu. The Parent List window will appear.
2. Select the parent to whose record you want to add medical information.
3. Click on the Modify button. The Modify Parent Information window will appear.
4. Click on the Misc tab.
5. Click on the Medical button. The Modify Medical Information window will appear.
6. Enter the Physician name.
7. Enter the physician’s Address, City, State and Postalcode.
8. Enter the physician’s Phone number.
9. Enter the Insurer’s name.
10. Enter the insurer’s Phone number.
11. Enter the parent’s Policy number.
12. If you want to add a picture of the physician, click on the Select button beneath the picture block. Locate the picture and the

click on the Open button.
13. Click on the Update button.
14. Click on the Update button in the Modify Parent Information window.

The medical information has been added to the parent’s record.

Child Information

The Child List and Modify Child Information windows are where you keep track of all the information you need about the
children. You can track their names, address, phone numbers, billing information, health information, contacts, picture, PIN # and
shot records.
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Ø  To add a child:

1. Select Parents & Children from the Childcare Menu. The Parent List will appear.
2. Select the parent of the child you want to add.
3. Click on the Children button. The Child List window will appear.
4. Click on the Add button. The Modify Child Information window will appear.
5. Enter the child’s Name and Nickname.
6. Enter the child’s Gender.
7. Enter the child’s Hair Color and Eye Color.
8. Enter the child’s Height and Weight.
9. Enter the child’s Birthdate.
10. Enter the child’s Starting Date.
11. Select Active from the Status list.
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12. Enter the child’s PIN #.
13. Enter the child’s Schedule. If you need to add a schedule, click on the Locate button next to the schedule list.
14. Enter the child’s Fee Rate. If you need to add a fee rate, click on the Locate button next to the fee rate list.
15. If you want to add a picture of the child, click on the Select button beneath the picture block. Locate the picture and the click

on the Open button.
16. Click on the Health tab.
17. If the child has any of the health problems listed, check the appropriate box.
18. If the child has any limitations, enter the information in the Limitations box.
19. If the child has any allergies, enter the information in the Allergies box.
20. If the child is receiving medical treatments, enter the information in the Medical Treatments box.
21. If the child is taking medication, enter the information in the Medications box.
22. Click on the Update button.

The child has been added to the child list.
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Ø  To add to a child’s shot record:

1. Select Parents & Children from the Childcare Menu. The Parent List will appear.
2. Select the parent of the child you want to add.
3. Click on the Children button. The Child List window will appear.
4. Select the child to whose shot record you want to add.
5. Click on the Modify button. The Modify Child Information window will appear.
6. Click on the Shots button. The Shot Record window will appear and display all the shots for the selected child.
7. Click on the Add button. The Modify Shot Record Information window will appear.
8. Select the name of the immunization from the Immunization list. If you need to add a new vaccine, click on the Locate

button next to the immunization list.
9. If you want to be alerted when the immunization is due, check the Alert When Due box.
10. Enter the Dates on which any previous shots have been administered.
11. Click on the Update button.

The vaccine has been added to the list and you will be alerted when the next time it is due.
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Ø  To note that a child has had a shot:

1. Select Parents & Children from the Childcare Menu. The Parent List will appear.
2. Select the parent of the child you want to add.
3. Click on the Children button. The Child List window will appear.
4. Select the child to whose shot record you want to add.
5. Click on the Modify button. The Modify Child Information window will appear.
6. Click on the Shots button. The Shot Record window will appear and display all the shots for the selected child.
7. Select the name of the shot from the list.
8. Click on the Modify button. The Modify Shot Record Information window will appear.
9. Enter the Date that the shot was given in the next available blank.
10. Click on the Update button.
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You will be alerted to immunizations that are due in two places. Whenever you modify the record of a child, Childcare Profes-
sional will check for immunizations that are due and will alert you if there are any. You can also check for immunizations that are
due by selecting Immunization Notification from the Childcare Menu.
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Ø  To check what immunizations are due:

1. Select Immunization Notification from the Childcare Menu. The Immunizations Due window will appear if there are any
immunizations due.

2. If you want to page through each child that has immunizations due, click on the Prev or Next buttons.
3. If there is an immunization to which you no longer want to be alerted, select the immunization and click on the No Notify

button.
4. Click the Done button.

Ratios

In some states, you can keep track of how many children that can be in your care by using ratios. Each child is worth a certain
point value as determined by how many children of its age group can be cared for by one childcare provider. Childcare Profes-
sional includes many of the ratios used by each state.
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Ø  To choose your childcare ratios:

1. Select Ratios from the Other Lists Submenu of the Childcare Menu. The Ratio List window will appear.
2. Select your state from the State list.
3. Select your facility type from the Type list.
4. The ratios for your state and type will be displayed.
5. Click on the Done button.

Childcare Professional is not set to your state and type of facility. Childcare Professional uses this information to determine the
current ratio listed on the Childcare Roster window as you check children in and out.
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Ø  To add your childcare ratios:

1. Select Ratios from the Other Lists Submenu of the Childcare Menu. The Ratio List window will appear.
2. Select your state from the State list.
3. Select your facility type from the Type list.
4. The ratios for your state and type will be displayed.
5. Click on the Add button. The Modify Ratio Information window will appear.
6. Enter the State abbreviation.
7. Enter the Type name.
8. Enter the Age Range in years.
9. Enter the number of Children per Caregiver allowed for the selected age range.
10. Click on the Update button.

The ratio has been added to the ratio list and is available for Childcare Professional to use in calculating the current child ratio.
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Ø  To modify your childcare ratios:

1. Select Ratios from the Other Lists Submenu of the Childcare Menu. The Ratio List window will appear.
2. Select your state from the State list.
3. Select your facility type from the Type list.
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4. The ratios for your state and type will be displayed.
5. Select the ratio that you want to modify.
6. Click on the Modify button. The Modify Ratio Information window will appear.
7. Modify the Age Range in years.
8. Modify the number of Children per Caregiver allowed for the selected age range.
9. Click on the Update button.

Childcare Roster

The Childcare Roster is the child time clock for Childcare Professional. You can check children in, check them out or just log their
hours. If you have schedules set up for your children, the Childcare Roster will use them.

����������� 	�# �
��� ������������������ 	�# �
��� ������������������ 	�# �
��� ������������������ 	�# �
��� �������

Ø  To check a child in:

1. Select Childcare Roster from the Childcare Menu. The Childcare Roster window will appear.
2. Select Not Present from the Status list. The list of children who are not already checked in will be displayed.
3. Double-click on the child that you want to check in.
4. Click on the Check In button.
5. If the child has a schedule selected, the Childcare Roster will automatically use the schedule and check the child in at that

time. If the child doesn’ t have a schedule for that day, the Modify Roster Information window will appear so that you can
manually enter the date and time. After you enter the date and time, click on the Update button.

The child will be moved to the present list with the check in time and date listed.
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Ø  To change the check in time:

1. If the Childcare Roster window is not open, select Childcare Roster from the Childcare Menu. The Childcare Roster
window will appear.

2. Select Present from the Status list. The list of children who are checked in will be displayed.
3. Select the child whose check in time you want to change.
4. Click on the Edit Times button. The Modify Roster Information window will appear.
5. Change the Time In to the correct time.
6. Click on the Update button.

The corrected time will be listed beside the child’s name.
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Ø  To check a child out:

1. If the Childcare Roster window is not open, select Childcare Roster from Childcare Menu. The Childcare Roster window
will appear.

2. Select Present from the Status list. The list of children who are checked in will be displayed.
3. Double-click on the child to be checked out.
4. Click on the Check Out button.
5. If the child has a schedule selected, the Childcare Roster will automatically use the schedule and check the child out at that

time. If the child doesn’ t have a schedule for that day, the Modify Roster Information window will appear so that you can
manually enter the date and time. After you enter the date and time, click on the Update button.

6. The Timecards Created window will appear so that you can double-check the timecards that were created.
7. If you want to change the times of a timecard, select the timecard and click on the Modify button.
8. If you don’ t want a particular timecard, select the timecard and click on the Remove button.
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9. Click on the Done button when you are finished.

The child is checked out and a timecard was created unless you removed it from the Timecards Created list.
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Ø  To log hours for a child:

1. If the Childcare Roster window is not open, select Childcare Roster from the Childcare Menu. The Childcare Roster
window will appear.

2. Select Not Present from the Status list. The list of children who are not checked in will be displayed.
3. Double-click on the child for whom you want to log hours..
4. Click on the Log Hours button.
5. If the child has a schedule selected, the Childcare Roster will automatically use the schedule. If the child doesn’ t have a

schedule for that day, the Modify Roster Information window will appear so that you can manually enter the date and time.
After you enter the date and time, click on the Update button.

6. The Timecards Created window will appear so that you can double-check the timecards that were created.
7. If you want to change the times of a timecard, select the timecard and click on the Modify button.
8. If you don’ t want a particular timecard, select the timecard and click on the Remove button.
9. Click on the Done button when you are finished.

The child’s hours have been logged and timecards created unless you removed them from the Timecards Created list.

Child Timecards

The child timecards are used by Childcare Professional to calculate the bills for parents. It is also used by the Time-Space Calcu-
lator to figure the total number of hours the business is in use.
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Ø  To change a child’s timecard:

1. Select Child Timecards from the Childcare Menu. The Child Timecard List will appear.
2. Select the parent’s name from the Parent list. The timecards for the selected parent will be displayed.
3. Select the timecard to be changed.
4. Click on the Modify button. The Modify Timecard Information window will appear.
5. Change the times to the correct times.
6. Click on the Update button.

The timecard has been modified. Childcare Professional will prompt you to recalculate the bill that contains the modify timecard.
Click on the Yes button if you want it to recalculate the bill.

Menus

Childcare Professional assists you in preparation of menus, meals and food lists. The meals are monitored to make sure they follow
the food programs guidelines.

���������
���
��������	�����������
���
��������	�����������
���
��������	�����������
���
��������	��

Ø  To add a food item:

1. Select Foods from the Menus Submenu of the Childcare Menu. The Food List window appears.
2. Select the type of food you want to add from the Food Type list.
3. Click on the Add button. The Modify Food Information window appears.
4. Enter the Food name.
5. Make sure the food Type is correct.
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6. Enter the number of Servings in the typical container Unit that you purchase.
7. Enter a 10 character alphabetical code in the Store Order box that Childcare Professional can use to print your grocery lists

in an order convenient for the stores you shop. For instance, the code FM-10A can be used if the item can be found at Food
Mart in the front half of Aisle 10.

8. Click on the Update button.

The food is entered in your food lists and ready to be used in creating meals.
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Childcare Professional monitors your meals to make sure they meet the requirements of the food programs. In the top-right corner
of the Modify Meal Information window, Childcare Professional lists a box for each of the required parts of a meal. As you add
components, the boxes are filled to show that you have that requirement met. When the meal has met all the requirements of the
food programs, the Update button becomes available so that you can save the meal.

Ø  To add a meal:

1. Select Meals from the Menus Submenu of the Childcare Menu. The Meal List window will appear.
2. Select the meal you want to add from the Meal Type list.
3. Click on the Add button. The Modify Meal Information window will appear.
4. Enter the Meal Name.
5. Click on the Add button. The Modify Meal Item window appears.
6. Select the Food Type for this component.
7. Select the Food Item you want. If you need to add a food, click on the Locate button next to the food item list.
8. Click on the Update button. One of the requirement boxes will be filled depending on which food type you added.
9. Continue to add foods until the requirements have been met.
10. Click on the Update button.

The meal has been added to the meal list and is ready to be added to a menu.
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Ø  To add a menu:

1. Select Menus from the Menus Submenu of the Childcare Menu. The Menu List window will appear.
2. Click on the Add button. The Modify Menu Information window will appear.
3. Enter the Menu name.
4. Click on the Update button.

The menu has been added to your menu list. You can now start adding meals to the menu.
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Ø  To add a meal to a menu:

1. Select Menus from the Menus Submenu of the Childcare Menu. The Menu List window will appear.
2. Select the menu to which you want to add a menu.
3. Click on the Menu Plan button. The Modify Menu Plan window will appear. It displays a list of all the meals already

contained in the menu plan.
4. Click on the Add button. The Modify Menu Item window will appear.
5. Select the Day of the Week on which you want a meal added.
6. Select the Type of meal you want to add.
7. Select the Meal name from the list of meals. If you need to add a meal, click on the Locate button next to the meal list.
8. Click on the Update button.

The meal has been added to your menu plan.
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Activities

You can plan an entire year’s worth of activities with multiple activities per day using Childcare Professional’s Activity Planner
calendar.

When you select the Activity Planner from the Childcare menu, it opens automatically to the current month and day. The day in
the calendar is bold and underlined. A list shows all the activities planned for the current day.  If you want to switch to another
day, simply click on the day. Any day with planned activities appears bold.

If you want to switch to a different month, select the month you want from the Calendar selection. Although the activities are only
one year’s worth, you can set the year so that the calendar days appear on the days of the week that they should for that month and
year.

If you want to add, modify or remove activities from the selected day, simply click on the corresponding button. When you are
done with the Activity Planner, click on the Done button.

You can have as many activities per day as you would like. You can use the Activity Planner to plan everything you do with your
children each and every day.
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Ø  To add an activity to the Activity Planner:

1. Select Activity Planner from the Childcare Menu. The Activity Planner window will appear.
2. Select the Month and Year for the date to which you want to add an activity.
3. Click on the Day to which you want to add an activity.
4. Click on the Add button. The Modify Activity Information window will appear.
5. Enter a Title for the activity.
6. Enter a Time of Day for the activity.
7. Enter a description of the Activity.
8. If you have supporting files such as stories or drawings, click on the Attach button. Locate the file and click on the Open

button. The file will appear in the files list.
9. Click on the Update button.

The activity will appear on the selected day’s activity list.

Activity Sets

When you start Childcare Professional for the first time, it will create an Activity Set for you called Standard.
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With Childcare Professional, you can create as many Activity Sets as you need. You can create a separate Activity Set for each
year of your business, or for each age group of children for whom you provide care

Ø  To create a new Activity Set:

1. Select Activity Planner from the Childcare Menu. The Activity Planner window will appear.
2. Click on the Locate button next to the Activity Set list. The Activity Set Management window will appear.
3. Click on the Add button. The Create New Activity Set window will appear. Enter the name of the new Activity Set you

would like to create.
4. Click on the Ok button. Your new Activity Set will appear on the list in the Activity Set Management window.



VIII-9

����������	��� 	�
��� ���� �����	������������	��� 	�
��� ���� �����	������������	��� 	�
��� ���� �����	������������	��� 	�
��� ���� �����	��

You can remove Activity Sets that you no longer need with the Activity Set Management window. Remember that once an
Activity Set has been removed, all the data contained in the Activity Set is permanently removed from your hard drive. Only
remove Activity Sets that you know are no longer of use to you.

Ø  To remove an Activity Set:

1. If the Activity Set Management window is not already open, select Activity Planner from the Childcare Menu. The
Activity Planner window will appear.

2. Click on the Locate button next to the Activity Set list. The Activity Set Management window will appear.
3. Select the Data Set on the list of Activity Sets that you want to remove.
4. Click on the Remove button.
5. Childcare Professional will warn you that you all the data in the selected Activity Set will be lost. Click on the Yes button.

The Activity Set has been removed.
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Chapter IX    

Reports

Report Controls

The Report forms are used to direct how and to where a report is to be printed.

One of the basic options in the Report forms is the destination of the report. You can select to preview the report on the screen,
send the report to the printer or save the report to a text file for editing. If you select File, you will be given an opportunity to
change the default text file name to a more appropriate name for the report. To change the name, click on the … button.

There are a five other basic options that may also be available depending on the report that you select.

Dates

You may be given the option of limiting the reported values to a time period with a Starting and Ending Date, or just an Ending
Date for all information up to a point in time.

Drop-Down Lists

You may be given the option of limiting the reported values through selecting values from a list such as Accounts, Types, Months,
Employees, Enterprises, Budget or Ownership. The report will only include those records that match the selected value.

Include Only Non-Zero Accounts

Many financial reports get cluttered with accounts that have a zero balance. You can remove those zero-balance accounts by
having the Include Only Non-Zero Accounts selected.

Check Boxes with Drop-Down Lists

Some reports give you optional lists of values with which to limit the reported values. To activate a list, just click on the corre-
sponding check box. The list will become active. Just select a value from the list to limit the report to that value.

Ordered Lists

Some reports give you the option of changing the order in which a list of items is printed. To change the order, simply click on the
Set Order button below the list. The Set List Order window will appear and allow you to change the order of the list.

Settings Menu

The Settings Menu gives you control over the way you work with reports in Childcare Professional. You can setup a report with
the settings that you like and save those settings to be used every time you view the report. Or you can create a new report with
those settings. You can also reset the report settings back to their original states.
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Ø  To save the settings for a report:

After you set all the controls in a Report Form, select Save Settings from the Settings Menu. The settings will be saved as the
default settings for the current report. Every time you open the current Report Form, the settings will be as you set them.
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Ø  To restore the settings for a report:

If you have changed some of the controls in a Report Form and you would like to change them back to the your standard settings,
select Restore Settings from the Settings Menu. The settings will be changed back the way the Report Form was when you opened
it.

����������	�	���� 	��	�
� ����	�����������
��	� ��������������	�	���� 	��	�
� ����	�����������
��	� ��������������	�	���� 	��	�
� ����	�����������
��	� ��������������	�	���� 	��	�
� ����	�����������
��	� ����

Ø  To reset the default settings:

If you have changed some of the controls in a Report Form and would like to change them back to the way they were when the
program was first installed, select Reset Defaults from the Settings Menu. Any changes you made to the settings since you
installed the software will be removed and all the controls reset.

Memorized Reports

Childcare Professional let you create your own reports by saving the settings of standard reports or other memorized reports under
a different name. If you need to print several configurations of a report, you can save each of the configurations under a different
name and just select them off the memorized report list when you need them.
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Ø  To create a new report:

1. Set all of the controls for a Report Form to the settings you want for your new report.
2. Select Memorize Report from the Settings Menu. The Enter Report Name window will appear.
3. Enter the Report Name.
4. Click on the Update button.

Your new report is saved and ready to be used anytime you need it.
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Ø  To run a memorized report:

1. Select Memorized Reports from the Reports Menu. The Memorized Reports window will appear.
2. Select the report you want to run.
3. Click on the Run button. Your saved Report Form will appear.
4. Click on the Done button when you are done running memorized reports

.
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Chapter X    

Technical Support

Help

There is a help topic for every window that appears in Childcare professional. If you get confused about what to do, the first thing
to do is press the F1 key.

If you are still uncertain what to do, use this manual to read about what you can do with the window you are in. This manual goes
into detail about how to do most of the day-to-day activities with Childcare Professional.

If after consulting the online help and the pages of this manual, you still need guidance, the next step is to ask Kask Software for
Technical Support. Please see the next section on how you can receive Technical Support from Kask Software.

Technical Support

Sometimes, due to the nature of computers, operating systems, software and hard drives, problems can occur. The best course of
action is to make a note of the following information:

1. What you were doing at the time of the problem.
2. The messages given to you about the problem including error number and message.
3. What operating system you are using. (E.g.: Windows 95, Windows 98, etc.)

There are several ways to obtain support from Kask Software. The support methods are:

Mail: Kask Software
P.O. Box 1143
Minot, ND 58702-1143

E-mail: support@kasksoftware.com
Web Site: www.kasksoftware.com
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Chapter XI    

Registration
Every time you startup Childcare Professional, a reminder will appear telling you how many days are left of your 30-day money-
back guarantee period. When the time runs out, you must register Childcare Professional with Kask Software in order to continue
using it.
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Ø  To register Childcare Professional:

1. Select Registration… from the Help Menu. The Confirm Registration window will appear.
2. Click on the link to the Registration web page.
3. Enter the 10-digit Serial Number listed in part 2 into the Registration Form. You should receive your confirmation number

by return email within one business day.
4. When you receive the Confirmation Number, enter it in the box in part 1.
5. When the correct confirmation number is entered in the box in part 1, the Ok button will be available.
6. Click on the Ok button.

Your software is now confirmed and you will be able to use it beyond the 30-day money-back guarantee period. After confirma-
tion, please close Childcare Professional and restart it so that it can properly set itself up
.



Appendix A

Memo Formats
There are several memos in Childcare Professional that are used in calculating bills and presenting billing statements and receipts
that allow you to use special codes so that you can personalize the messages for the child or parent that it is intended for. You can
use the following codes in Receipt and Billing Memos:

%pf% This will be replaced by the parents’  first name whenever the memo is used.

%pl% This will be replaced by the parent’s last name whenever the memo is used.

%cf% This will be replaced by the child’s first name whenever the memo is used.

%cl% This will be replaced by the child’s last name whenever the memo is used.

For example, if you wanted a receipt memo to say ‘Thank you, Seth, for your payment.’  You would enter the following in the the
receipt memo blank:

Thank you, %pf%, for your payment.


